MS Excel-II
Contents

Creating a household budget ................................................................. 1-8
Using AutoSum ....................................................................................... 5
Doing the math ......................................................................................... 6
Renaming a worksheet ........................................................................... 6
Adding worksheets ................................................................................ 6
Adding Gridlines for Print Preview/Printing ........................................... 7
Saving the workbook ............................................................................. 7
Adding/Removing cells/rows ................................................................. 7-8
Delete an entry ....................................................................................... 8
Creating a checkbook register ............................................................... 8-12
Formatting a row ................................................................................... 9
Change date formatting ........................................................................ 9-10
Add data ................................................................................................. 10-11
Print a checkbook register worksheet .................................................. 11
Add row shading ................................................................................... 12
Create a column chart ......................................................................... 13-17
Add a chart title .................................................................................. 14
Creating totals ...................................................................................... 15
Changing the total by editing a number ................................................. 15
Add formatting ..................................................................................... 15
Add color to every other row ............................................................... 15
Add a border ......................................................................................... 16
Print Preview ......................................................................................... 16-17
Use AutoFill ........................................................................................ 18
Remove duplicate entries .................................................................... 18
See all the formulas on a worksheet .................................................... 18
Put the heading row data on the top of each page ............................... 18
Getting Help ......................................................................................... 18
Creating a household budget

It’s really useful to have a monthly budget to track your expenses. You can type the budget items that fit your lifestyle, such as the examples with this project.

**Tip.** Remember to use Enter to move down a row and Tab to move across.

Open MS Excel 2013.
- In cell A1, type Monthly Budget and press Enter. PRESS ENTER after each entry.
- Click on cell A1 and change the font size to 14.
- In B2, type Projected.
- In C2, type Actual.
- In A3, type Home Expenses.
- In A4, type Mortgage/Rent.
- In A5, type Mort/Rent Insurance.
- In A6, type Electricity.
- In A7, type Gas/Oil.
- In A8, type Water/Sewer.
- In A9, type Trash.
- In A10, type Phone.
- In A11, type Cable/Satellite.
- In A12, type Internet.
- In A13, type Lawn/Garden.
- In A14, type Other.
- In A15, type Total.
- In A17, type Daily Living and press Enter.
- In A18, type Groceries.
- In A19, type Eating Out.
- In A20, type Clothing.
- In A21, type Hair/Nails.
- In A22, type Club Fees.
- In A23, type Dry Cleaning.
- In A24, type Health Insurance.
- In A25, type Life Insurance.
- In A26, type Medical/Prescriptions.
- In A27, type Other.
- In A28, type Total.
- In A30, type Entertainment.
- In A31, type Movies/Theater.
- In A32, type DVDs/CDs/iTunes.
In A33, type Concerts.
In A34, type Sports.
In A35, type Toys/Gadgets.
In A36, type Vacation/Trips.
In A37, type Other.
In A38, type Total.
In A40, type Transportation.
In A41, type Auto Loan/Lease.
In A42, type Auto Insurance.
In A43, type Fuel.
In A44, type Auto Maintenance.
In A45, type License/Registration.
In A46, type Bus/Taxi.
In A47, type Other.
In A48, type Total.
In A50, type Income.
In A51, type Take Home Pay 1.
In A52, type Take Home Pay 2.
In A53, type Other Income.
In A54, type Total Income.
In E3, type Children.
In E4, type Daycare/Tuition.
In E5, type Clothing.
In E6, type Medical/Prescriptions.
In E7, type School Lunches.
In E8, type School Supplies/Fees.
In E9, type Babysitting.
In E10, type Toys/Games/Gifts.
In E11, type Other.
In E12, type Total.
In E14, type Pets.
In E15, type Food/Toys.
In E16, type Medical.
In E17, type Grooming.
In E18, type Other.
In E19, Total.
In E21, type Obligations.
In E22, type Student Loan.
In E23, Type Credit Card 1.
In E24, type Credit Card 2.
In E25, type Credit Card 3.
In E26, type Alimony/Child Support.
In E27, type Legal/Accounting Fees.
In E28, type Taxes.
In E29, type Other.
In E30, type Total.
In E32, type Savings.
In E33, type Emergency.
In E34, type Retirement.
In E35, type Investments.
In E36, type College.
In E37, type Other.
In E38, type Total.
In E40, type Gifts/Donations.
In E41, type Birthday/Holiday.
In E42, type Charity 1.
In E43, type Charity 2.
In E44, type Church.
In E45, type Other.
In E46, type Total.
In E50, type Total Projected Expenses.
In E51, type Total Actual Expenses.
In E52, type Total Income Less Expenses. (To show how much you will have left or have overspent).
In F2, type Projected.
In G2, type Actual.

Click on Column B to select the entire column and click on the $ in the Home tab and Number Group. Repeat this step for columns C, F, and G. This will add dollar sign formatting to all the numbers you type in.

To adjust the column spacing, since the text in columns A and E are running into the next columns, place the mouse pointer on the line between columns A and B and double-click to expand it. Repeat this step for E and F.

Click on Print Preview. Doing this will place dashed lines around the information that will appear on one page, if you print it. To keep all the information on a single page, place the mouse pointer on the space between columns D and E, and click and drag to the left until the column looks about ¼-inch wide. If all the information doesn’t appear within the dashed lines, make column D narrower.
To make the headings stand out, click and drag over Projected and Actual in row 2 and use the Ctrl+B shortcut to make them bold. You can also click on the Bold button in the Font Group. Click and drag between B & C and F & G to adjust the spacing, if it cuts off any letters.

Add Bold to all the group headings: Home Expenses, Daily Living, Entertainment, Transportation, Income, Children, Pets, Obligations, Savings, and Gifts/Donations. Also add Bold formatting to all the cells that have the word Total in them.

**Tip:** If you want to add special formatting, like Bold or a specific font size, you can click in the first cell and make the change, and then double-click on the Format Painter in the Clipboard group. Now, click on the other cells you want to have the same formatting, such as Bold. Click on the Format Painter to turn it off when finished.
Using AutoSum
There are a few ways to create totals for each group:

1. Type a number in the first entry for each group, click and drag over the cells in that group, and click on the AutoSum button in the Editing Group.
   a. Ex. for the Home Expenses group, type a number, such as your mortgage or rent amount. Click and drag over cells B4 through B15 and click on the AutoSum button.

2. Manually type the formula in the Total cell for that column.
   a. In order to create a blank budget that can be used to create a budget for each month of the year, click in cell B15 and type =sum(b4:b14)
      i. When typing formulas, you can use lowercase letters
   b. This formula tells Excel that you want to add cells B4 through B14 and put the total in cell B15.

Tip: Once you create a total for a group in column B, while it’s still highlighted, click on the little black box in the lower right corner and drag across to the Total cell in column C. It will automatically AutoSum it! This will work if there are numbers in the cells and even if you are using the formula option 2 above.

Do an AutoSum for each remaining group: Daily Living, Entertainment, Transportation, Income, Children, Pets, Obligations, Savings, and Gifts/Donations.

Income
To total your income, repeat the steps you used above. Click in cell B54 to total the cells B51 through B53. Do this for those cells in column C, using the method of your choice.
Doing the Math
To take the fuss out of doing the math to learn how much was spent during a given month, let Excel do most of the work.

In cell F50, the Total Projected Expenses cell, type
=sum(b15,b28,b38,b48,f12,f19,f30,f38,f46) and press Enter. **Notice there are no spaces between anything in this formula.**
In cell F51, the Total Actual Expenses cell, type
=sum(c15,c28,c38,c48,g12,g19,g30,g38,g46) and press Enter.

**OR** you can use the cell pointing technique:
In cell F50, type =sum( and click on cell b15 and press the comma key, click on the remaining total cells, and end with a ). Then, press Enter to total those sums. It will still look like this =sum(c15,c28,c38,c48,g12,g19,g30,g38,g46) in the cell address window.

To figure the amount of income minus expenses, click in click in cell F52 and type
=sum(c54-f51)

**Renaming a worksheet**
Double-click on the Sheet 1 tab at the bottom and type the month of your choice, such as Jan. Press Enter or click on a blank cell.

**Adding new worksheets for each month**
Now that the totals are ready to go, you can save a budget for each month of the year. Click on the box in the upper left corner to select all the cells. Use the Ctrl+C shortcut to copy the selected cells.

Click on the Sheet 2 tab at the bottom and use the Ctrl+V shortcut to paste the budget information into the worksheet. This saves having to re-create the budget for each month. Repeat this process for each month you wish to add. Rename the sheet tab for each month.
Adding gridlines
If you want to see gridlines when printing or even viewing with Print Preview, click on the Layout tab and then under Gridlines in the Sheet Options Group, click on the box next to Print.

Saving the workbook
Once you're ready to save (not in this class), click on File in the upper right corner and click on Save as. Choose a location to save the file, such as your Desktop or a flash drive or click on Browse to choose a specific folder in which to save the file. Type Monthly Budget and add the current year, such as Monthly Budget 2013. Click on Save.

Click on the Back arrow to get back to your workbook.

Adding or removing cells/rows
To add a cell or row in an existing worksheet, click on a cell or click and drag across multiple cells below the row where you want to add new cells or rows (the new cells will be above that row). In the instance below, all three cells across three columns are selected, because there was information or formulas in them. If you just shift the first cell, it will throw off the information and formulas for the rest of the worksheet.

Right-click anywhere on the selected cells and click on Insert. This pop-up will appear.

Click on OK to choose the Shift cells down option. This will keep the formulas intact. Type the new information in the appropriate cell(s).
To delete an entry
Click and drag over the cell or multiple cells to select them. Right-click on the selected cell(s) and click on Delete.

Click on OK to choose the Shift cells up option.

Tip: You can insert or delete columns the same way as deleting cells and rows.

Creating a Checkbook Register

There are programs you can buy for your computer, like Quicken, but if you just want to create a spreadsheet to track bill paying while letting it do the math, you can use Excel!

Open a blank spreadsheet (Ctrl+N)
In cell A1, type Checkbook Register. Click in the blank space and back on A1 to select it. Change the font size to 12 and click on the Bold button or use Ctrl+B to add Bold formatting. In cell A3, type Check # /Online (add a space after the # sign). In B3, type Date. In C3, type Transaction. In D3, type Debit (-). This column is for checks you’ve written, visits to the ATM, and Debit card amounts. In E3, type Credit (+). This column shows deposits that have been added to your checking account, such as your direct deposit pay. In F3, type Balance. Once the formula has been created, this will be the running total of how much money you have in your account. In G3, type Cleared (Type an X in this spot, when you get your bank statement to show a check has cleared and the monies have been paid out).
To format row 3
Double-click on the line between Columns A and B to expand the width of the column. If you want to tighten the space, place the mouse pointer on the line between A and B and drag it a little to the left, so it’s about 1-inch wide. To wrap the text in that cell, so it doesn’t take up so much space, click on A3, and on the Wrap Text button in the Alignment Group on the Home tab.

You can use the above steps to resize the columns as necessary. Click and drag between C and D to make the column about double in width, since this will be the place where you will have to type more information.

Click and drag over the cells A3 to G3 to select them. Click on the Center button in the Alignment group, and while they’re selected, use the Ctrl+B shortcut.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To add dollar sign formatting, click and drag over Columns D, E, and F and then on the $ in the Number Group.

To change the date formatting
If you type a date, such as 9/22 in the date column and press the Tab or Enter keys, the date will automatically change to 22-Sep, the default for Excel. To adjust this, click on cell B4, on the down arrow under Format in the Cells Group, and then on Format Cells. Click on Custom and in the Type window, type m/dd and click on OK.
To add this formatting to the rest of column, click on the little black box in the lower right corner and click and drag straight down through Row 54 (this is the end of the page. To see the page boundaries, click on the Print Preview in the QAT).

**To add data**

To begin the initial Checkbook Register, type a beginning balance from your checkbook or bank statement in F3. For today, type 1000. In cell =F4+E5-D5 and press Enter.

This will add any money that is credited to the register and subtract any amount that is debited, while keeping a running total.

To make it easy to keep the total as you add more information, click on F5 and click and drag on the tiny box in the lower right corner all the way through F54.

When you’re done, it will look like this all the way through F55:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checkbook Register</td>
<td></td>
<td></td>
<td>Debit (-)</td>
<td>Credit (+)</td>
<td>Balance</td>
<td>Cleared</td>
<td></td>
</tr>
<tr>
<td>Check #/Online</td>
<td>Date</td>
<td>Transaction</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td>$1,000.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To create monthly registers
It’s best to keep a monthly register, so the file doesn’t get so cumbersome. Do this by creating a new worksheet for each month of the year. Click in A1 and use the Ctrl+Shift+End shortcut to select all the data from cell A1 to G54 without having to click and drag over it. While the data is selected, click on Copy in the Clipboard Group or use Ctrl+C to copy the data. Click on Sheet 2 at the bottom, click in cell A1 and use the Pasta button or Ctrl+V to paste the data into a new worksheet. Adjust the cell spacing as necessary.

Currently, on subsequent worksheets, you’ll see #### in the Balance column (because it’s not sure what number will go there). When you type the beginning balance for each month, that number will fill the cells in column F.

Tip: To get rid of the marching dashes from copying a selection, press the Esc key.

Right-click on Sheet 1 and click on Rename to type a new name for this worksheet. Repeat this process for each month of the coming year.

Now, for practice, in A5, type 1234.
In B5, type today’s date as mm/dd. Ex. 9/22 or 12/15.
In C5, type Target.
In D5, type 50.
When you press Enter or Tab, the total should change to $950.
In A6, type 1235.
In B6, type a date.
In C6, type Duke.
In D6, type 88.27. and press Enter.
In B7, type a date.
In E7, type 100. and press Enter.

Just like magic, Excel does the math for you! As long as you type the amounts correctly, no more mistakes!

To print a Checkbook Register worksheet
Click on Print Preview to make sure all the information is within the dashed lines. If it’s not, adjust the width of the cells or delete unnecessary rows.

To allow a little more space, in case you wish to print the register, click on Page Layout and on Margins. Click on Custom Margins and change the Left and Right margins to .45.

Don’t forget to add Gridlines, as shown on page 7.
Adding row shading

Want to make it look more like a checkbook register? Add shading to every other row.

1. Click on cells A3 through G54 to select those cells.
2. On the Home tab, click on the down arrow next Conditional Formatting in the Styles Group, and then on Manage Rules.
3. Click on New rule.
4. Click on Use a formula to determine which cells to format.
5. In the Format values where this formula is true box, type =MOD(ROW(),2)=1
   a. This tells Excel that you want to shade every other row of the selected group of cells.
6. Click on Format.
7. Click on the Fill tab to choose the color you’d like every other row to be and click on OK, OK, and on OK again.
8. Click off in the blank space and you should see your highlighting!
Create a column chart
Want to track stocks and bonds? Want to track your utility use? It’s easy to have a visual image of data like this by creating a chart.

Open a blank Excel workbook (Ctrl+N).
In cell A1, type Utility Usage and the current year. Click in any empty cell and back in A1. Change the font style to the font style of your choice and change the font size to 14. Add Bold formatting.
In A3, type Company.
In B3, type Jan and press the Tab key. Click back on cell B3, on the little box in the lower right corner, and drag to the right until you see all the months of the year…Feb, Mar, … Let go of the mouse when you see the Dec appear.

![Excel sheet with columns for Company and Jan to Dec]

Bold the text in Row 3.

Add the data
In cell A4, type Duke Energy.
In A5, type Owen Electric.
In A6, type BC Water.
Adjust the column spacing by clicking and dragging between A and B.
In B4, type a number you might pay for a gas/electric bill.
In B5, type a number you might pay for an electric bill.
In B6, type a number you might pay for the water bill.
Want to add dollar formatting? Click and drag over cells B4 through M6 and click on the $.
Type numbers in the remaining cells through the month of Dec. You can do quarterly amounts for the water bill.

![Excel sheet with data for Duke Energy, Owen Electric, and BC Water]
To create a quick chart, click and drag over cells A3 through M6, on Insert, on Inset Column Chart, and click on the first option under 2D – Clustered Chart.

Click in the blank space when done. You can click and drag to move the chart. Click on the chart and then on the Design tab/Chart Styles to see some ways to jazz up the chart.

Add a chart title
If you're just going to print the chart without the rest of the data on the worksheet, click on the chart to select it. Click on Chart Title and use the Ctrl+A shortcut to select the text. Type Utility Usage and the current year.
Creating totals
If you want to add a total for each column to see the amount spent each month, click and drag over cells B4 through B7 and click on the AutoSum button. To create totals for the other columns, click on a blank cell and back on the lower right corner of cell B7 and drag across through cell M7. This will automatically add totals, so you don’t have to AutoSum each column.

Changing the total, by editing a number
When using the AutoSum function, if you change a number in your data information, it will automatically recalculate the totals. Click in cell C5 and change the number to 43. and press Enter or Tab. Notice how it changed the column total and the total in cell C7.

Add formatting
To highlight an entire row, click and drag over cells B7 through M7. To add color, click on the Home tab, on the down arrow next to Fill Color in the Font Group, and then choose a color.

Add color to every other row
Select cells A3 through M7. On the Home tab, click on Format as Table in the Cells group and on Table Style Medium 1.

Click on the box next to My table has headers and on OK.

© Boone County Public Library  www.bcpl.org
10/13 JU
To add a border
Instead of adding color to a row, you can highlight it with a border. You can add borders to the top, bottom, side, or all around a cell. To add a border at the top of the cells in the total row, click on cells B7 through M7 to select them. Click on the down arrow next to the Border button in the Font Group, and click on the Top Border choice.

Print Preview
To see what the whole page will look like, make sure the chart isn’t selected and click on the Print Preview button on the QAT or on File and on Print. Click on the Back arrow to go back to your document.
In this case, the information is wider than what will print on an 8.5x11 sheet of paper in the portrait view (look at the dashed lines that appear). To correct that, click on the Page Layout tab, Orientation, Landscape. Adjust the column widths, but if that still pushes information beyond the page border, adjust the margins using the information on the bottom of page 11. Click and drag the chart so it’s centered below the information.

To print the data with the chart, click on File and then on Print.

To print only the chart, click on it to select it. You can click on File and Print or while viewing the chart in Print Preview and on the Print button.
Helpful Tips

When using AutoFill, remember to hold down the Ctrl key when dragging across a row for numbers (1, 2, 3…). Also, AM needs to be AM or PM, not a.m. or p.m.

Remove duplicates (numbers or text)
Click on the box at the intersections of rows and columns to select all cells or use Ctrl+A. Click on Data, and on Remove Duplicates in the Data tools section. Click on OK and on OK again.

See all the formulas on a worksheet at once
If you’re not sure what the formula is for a group of cells, view them all at once by using the Ctrl+~ shortcut.

Put the heading info into the first row on every page
Click on Page Layout and then on Print Titles. Click in the window next to Rows to repeat at top, type A1 to specify the information in row A1, and click on OK.

Getting Help
Use the F1 key or click on the Help question mark button on the far right of the tabs row. In the Search window, type in the keyword(s) you think will bring the best results.

More helpful tips – on our home page, click on Information Desk/Computer Classes.